4.0 FEMIS PC Installation

The following sections describe the steps needed to install FEMIS on a PC.

4.1 Installing the PC COTS

The order for installing the COTS on a new FEMIS PC is as follows:

1. Windows 2000 Service Pack 2 or Windows NT 4.0 Service Pack 6

2. Internet Explorer 4 or above (for Windows NT only)

3. Oracle Net8 Client v8.1.6 and ODBC Driver v8.1.6.2

4. ArcView GIS v3.1 and v3.1.1 patch

5. Microsoft Data Access Components v2.1 (only for new installs on Windows NT 4.0 PCs)

At the end of this section, PNNL has provided two checklists that can be used for each PC
installation.

e FEMIS PC Installation Checklist

e FEMIS PC Validation Checklist.

4.1.1 Installing Windows 2000 Service Pack 2 or Windows NT 4.0
Service Pack 6

Service packs for the operating system are on the COTS CD for FEMIS v1.5. For Windows 2000
Service Pack 2 should be installed and for Windows NT 4.0 Service Pack 6 should be installed.

To install Windows 2000 Service Pack 2, insert the FEMIS v1.5 COTS CD into the CD drive and
complete the following steps.

1. Double-click on <COTS DRIVE>\W2KSP2\w2ksp2.exe t0 extract the files.
2. Accept the license agreement, and the installation process begins.

3. Restart the PC when the installation process has completed.
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To install Windows NT Service Pack 6, insert the FEMIS v1.5 COTS CD into the CD drive and
complete the following steps:

1. Double-click on NT4SP6a/SP61386.EXE to extract the files.
2. Accept the license agreement, and the installation process begins.

3. Restart the PC when the installation process has completed.

4.1.2 Installing Internet Explorer
For FEMIS to install and function correctly on Windows NT 4.0 PC, Internet Explorer v4 or above

needs to be installed. A copy of Internet Explorer v5.5 is included in the COTS CD and can be
installed by running <coTs drive letter>:\IE5.5\ie5setup.exe.

4.1.3 Installing Oracle Net8 Client v8.1.6 and ODBC Driver v8.1.6.2
Both Oracle Net8 Client v8.1.6 and ODBC Driver v8.1.6.2 must be installed for FEMIS v1.5.
4.1.3.1 Installing Oracle Net8 Client v8.1.6

Note: When Oracle Universal Installer is installed, Java Runtime Environment 1.1.7.24
will also be installed. If you use a later version, you may need to reinstall it.

To install Oracle Net8 Client v8.1.6, insert the FEMIS v1.5 COTS CD into the CD drive and
complete the following steps:

1. Login to Windows as a user with Administrator privileges.
2. Start Windows Explorer, and browse to <COTS drive letters:\Oracle8ls.

3. Select the seTUP. EXE program, and run it by clicking open and ok. The Oracle Universal
Installer will start.

4. Click next on the Welcome window.

5. Check the path on the File Locations window under Destination Path if you are upgrading to
ensure Oracle installs in the same path where v8.1.5 was installed. Click Next to continue.

6. Choose custom on the Installation Types window. Click Next.
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7. Ensure boxes on the Available Products window are checked next to the following products.
Net8 Products
Net§ Client
Net§ Client
Oracle Installation Products
- Oracle Universal Installer
Uncheck all unneeded products.
Note: These are the minimum required products for FEMIS. If you need additional items,
they can be installed also, but it may require additional configuration during setup
that is not covered in this document.
Click nNext.
8. Click next on Component Locations window.
9. Click 1nstall on the Summary window.
After Oracle products are installed, the Configuration Tools window may appear and attempt to
run the Net8 Configuration Assistant. If this happens, select the Net8 configuration
Assistant and click cancel. Click Yes to confirm the cancellation, click ok on the error

message window that appears, and then click Next.

10. Click Exit on the End of Installation window—unless you need to install the ODBC Driver
v8.1.6.2, then click Next Install and proceed to Step 3 of the next section.

41.3.2 Installing Oracle ODBC Driver v8.1.6.2

Before you can install the ODBC driver 8.1.6.2, Oracle Net8 Client 8.1.6 must be previously
installed. Insert the FEMIS v1.5 COTS CD into the CD drive and complete the following steps:

1. Click start 2 Programs > Oracle Installation Products = Universal Installer.
2. Click Next in the Welcome window.

3. Browse to <COTS drives:\ODBC8162\Diskl\stage\products.jar for the Source.. Path.
Click Next.

4. Click 1nstall in the Summary window.

5. Click Exit in the End of Installation window.
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4.1.4 Installing Microsoft Data Access Components on
Windows NT PCs

Note: If you have FEMIS v1.4.7.2 installed, Microsoft Data Access Components (MDAC)
has probably been installed on Windows NT PCs. If this is a new install on a
Windows NT PC, then complete this section.

For PCs using Windows NT 4.0, MDAC 2.1 or above must be installed. To install MDAC, insert the
FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login to Windows as a user with Administrator privileges.
2. Select <cD drives:\mdac_ typ.exe, and run it.

3. Select the icon for complete installation.

4.1.5 Installing ArcView GIS v3.1 and v3.1.1 Patch

If you have FEMIS v1.4.7.2 installed, ArcView v3.1 and v3.1.1. patch should already be installed so
you can skip this section.

Note: If you reinstall ArcView GIS after having already installed FEMIS, the correct
version of the file DEFAULT. APR Will be overwritten by the ArcView GIS installation.
Copy the DEFAULT . APR file from your c:\FEMIS directory to the
<DRIVE>\ESRI\AV GIS30\ARCVIEW\ETC directory on the PC. If you cannot find
C:\FEMIS\DEFAULT.APR, then the file may be copied from
/home/femis/pc/femmisc/ On your server.

Note: ArcView GIS v3.1 must be installed on the computer before you install the v3.1.1
patch, and the patch must be installed for FEMIS to work properly.

If an older version of ArcView GIS is currently on the PC, remove it before installing ArcView
GIS v3.1.

Note: If more than one version of ArcView GIS is installed on the PC, FEMIS will find the
most recently installed version. If you have multiple versions of ArcView GIS
installed, check the swinpIrs\FEMIS. INI file after the FEMIS installation is
complete to make sure that the file references the correct installation.

41.5.1 Installing ArcView GIS v3.1

You will need to have the ArcView GIS license number for this installation. The CD key number is
located on the ArcView GIS installation disk or included with its documentation.
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To Install ArcView GIS v3.1, insert the FEMIS COTS CD into the CD drive, and complete the
following steps:

10.

11.

12.

13.

14.

. Login to Windows as a user with Administrator privileges.

Select <CD drives:\AV3.1\SETUP.EXE, and run it.

. Click next in the Welcome window.
. Click ves in the License Agreement window.

. Choose L.ocal install for installation type. Click Next.

Select custom and other options you may want to install. Click Next.
Note: If you are upgrading, click ves to replace current installation.

If you are attempting to upgrade and you are not prompted to replace the current
installation, click Back and verify the install destination has ArcView installed.

Deselect the Map data and Launch Seagate Crystal Reports 6.0 setup. Click Next .

Note: Map data and Seagate Crystal Reports are not used by FEMIS but can be installed if
desired.

Click next to accept the defaults for program Folders and Existing Folders. The Start
Copying Files window displays.

Click Finish to start copying the files.

Click ox in the information window.

Click ves and Finish on the Setup Complete window to restart the computer.

Re-logon to the computer using the same user account that was used to install ArcView.

Click start > Programs - ESRI - ArcView GIS version 3.1 = ArcView GIS

version 3.1.

Enter the name and organization and the ArcView GIS license number. Click ox, and ArcView
GIS will start.
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15. Deselect the show this window when ArcView GIS Starts box on the Welcome to ArcView
GIS window. Click cancel.

16. Click File - Exit to close The ArcView GIS v3.1 application.
4.1.5.2 Installing ArcView GIS v3.1.1 Patch
Note: ArcView GIS v3.1 must be installed before installing ArcView GIS v3.1.1 patch.

To Install ArcView GIS v3.1.1 patch, insert the FEMIS COTS CD into the CD drive, and complete
the following steps:

1. Login to Windows as a user with Administrator privileges.

2. Select <CD drives:\AV3.1 PATCH\AV31PATCH.EXE, and run it.

3. Click ves to continue the installation of ArcView GIS v3.1.1 patch.
4. Click Next to accept the default Local Install.

5. Click next to accept the default destination location.

6. Click Next in the Review Current Settings window that displays inside the Start Copying Files
window.

7. Click rFinish and reboot the PC before using ArcView GIS v3.1.

4.1.5.3 Creating the ArcView GIS Icon for All Users

The ArcView installation only installs the ESRI Program folder that contains the ArcView GIS 3.1
icons for the user that installed the software. If you would like more than this user to run ArcView
from Program folders, you will need to copy the ESRI Program folder to the a11 users profile.

FEMIS does not require ArcView GIS v3.1.1 be in Program folders.

To copy the Program folder from the installer’s user profile to the a11 users profile, use the
following procedure:

1. Login to Windows as a user with Administrator privileges.

2. Browse to the $WINDIR%\PROFILES\<Installation users>\Start Menu\Programs or
$SYSTEMDRIVE$\DOCUMENTS AND SETTINGS\<Installation users>\Start Menu\Programs.

3. Right click on the Esr1 folder and select cut.
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4. Browse to the $WINDIR$\PROFILES\All Users\Start Menu\Programs or
$SYSTEMDRIVE%\DOCUMENTS AND SETTINGS\All Users\Start Menu\Programs.

5. Right click on the programs folder and select paste.

4.1.6 Installing Other COTS

The following COTS products should be installed using the installation documentation for each
product.

E-mail application (if desired)

Use the standard product installation notes provided with the software.

4.2 Configuring the FEMIS Setup Program

CAUTION

Configuration is only done once at each EOC. Stop PC installation until all configurations
have been performed.

Several other files must be configured for your site or EOC. Most of these files should have been
configured during the FEMIS UNIX installation but should be validated before installing the FEMIS
application on the PCs.

Note: Directories specified below are from the PC. You will need to use the UNIX version
of these directories if you are editing files from the UNIX server.

4.2.1 Connecting the Network Install Drive

To connect the FEMIS network drive to the install directory, complete the following steps. The parts
in italics are what should be changed.

1. Obtain the shared name of the FEMIS account home directory from your System Administrator.
Example: \\<servers>\femis.

2. Open Windows Explorer.
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3. Select Tools > Map Network Drive menu option, and fill in the fields in the Connect Network
Drive window as follows.

Drive: 1:\

Path: \\<server >\femis

For Windows 2000, click on connect Using a different user name. On the Connect As
window, enter as femis in the User name field and in the Password field, enter the server femis
account password.

For Window NT, Connect as: femis and enter femis in the Connect as: field. Enter the server
femis account password when prompted.

Any available drive letter can be used in place of 1:\ for the installation drive. However, this
documentation will assume that FEMIS is being installed from the 1:\ drive. If you have another
drive mapped to the server (such as M:\) as a user other than femis, you will need to disconnect it.

4.2.2 Validating the \CONFIGD\FSETUP.INI File

The FEMIS Setup program uses a configuration file to determine the defaults for the installation.
Validate that the 1:\conr1GD\FSETUP. INT file was correctly configured during the server
installation.

Note: The site and EOC values need to be uppercase.
The first section of the 1NT file, the [Setup Defaults] section contains entries that set defaults for

the Setup program. Starred items (*) are those that should have been configured by the UNIX
installation scripts.

Sitex Default site code. This should be the FEMIS four-letter code for
your site.

EOC* Default EOC code. This should be the FEMIS four-letter code for
your site.

DestDir Default installation destination directory for new installations.

Re-installations and upgrades will default to the current FEMIS path.

Version Gives the version of FEMIS for which this instance of FSETUP. INI was
created.

DateThisFSETUPCreated Gives the build date for this version of FEMIS.
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mDriveNetPath* Path to the FEMIS m:\ drive that the FEMIS startup script will connect.
This does not need to be set if you use an alternate method to map the
M:\ drive. Enter this specification only if you desire to have
fstartup.exe attach the m:\ resources on the majority of PC installations.

LocalStartupScript Full path for a local startup script to be run by the FEMIS startup script.
This is optional.

EMIS_StartupScript Full path to the EMIS startup script file. The FEMIS startup script file
will run this file.

fupdateLocation The UNC Path for the location of FUPDATE.BAT is used to update
files on the user’s PC. Refer to Section 4.2.8, Updating Files on All PCs
Using FUPDATE.BAT.

The second section of the 1N1 file, the [sites] section, is used to fill the Site drop-down list in the
Select Site and EOC window in the PC Setup program. You can edit this list to limit the possible
selections available in Setup. Each site entry must be formatted as siteNN=<SITECODE> where NN is
a two-digit integer and <sITECODE> all uppercase. If you shorten the list of sites to a single entry,
the user will be forced to accept that entry when running Setup. If you edit the list, the numbering for
the sites must be sequential, starting at o1.

Subsequent sections are lists of EOCs for each site in the [sites] section. Each site listed in the
[sites] section must have a corresponding [<SITECODE> EOCs] section. These sections are used to
fill the EOC drop-down list in the Select Site and EOC window in the PC Setup program when the
corresponding site is selected on the same window. The EOC list sections can be edited in the same
manner as the Site list. Each EOC entry must be formatted as EocNN=<EOCCODE> where NN is a two-
digit integer and <Eoccope> must be all uppercase. If you shorten the list of EOCs to a single entry,
the user will be forced to accept that entry when running Setup. If you edit the list, the numbering for
the sites must be sequential, starting at 01. EOC list sections that do not have a corresponding site
listed in the [sites] section will be ignored.

4.2.3 Validating the \CONFIGD\TNSNAMES.ORA File

The TnsNaMES . oRA file should be configured with the correct database names, listeners, and 1P
addresses. This file should be a copy of $TNsS_ADMIN/TNSNAMES.ORA on the UNIX server. For each
listener on each server, it should contain a section like the following. The parts in lfalics are what
should be changed.

fi ctoo =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS =
(COMMUNITY = TCP)
(PROTOCOL = TCP)
(HOST = ctoosun.utah.gov)

4-9



Federal Emergency Management FEMIS Installation Guide
Information Systems (FEMIS) April 26, 2002—Version 1.5

(PORT = 1521)
)
)
(CONNECT DATA =
(SID = fi ctoo)
)
)

Note: The setup program will not copy the TNsSNaAMES . OrA file to a PC if that PC already
has a TNsNaMES . ORA file. See Section 15.2, FUPDATE.BAT in the System
Administration Guide for FEMIS Version 1.5 for more details on how to configure
FUPDATE . BAT, if you need to update the TnsNaMES . ora file on all of the PCs that
will be running FEMIS.

4.2.4 Validating the \CONFIGD\ADDODBC.BAT File

FEMIS uses the 1:\UsErR\ADDODBC.BAT batch file to add all the necessary ODBC data source names
to each PC. Verify that the mapping from EOC code to listener ID is correct for each line.

4.2.5 Validating the \CONFIGD\AUTOEXNT.BAT File

During the installation process, the I:\CONFIGD\AUTOEXNT.BAT file is copied to the
SWINDIR%\SYSTEM32 directory, usually c:\wINNT\sysTEM32. This file should contain the following
commands. The <TEMPLATE HOSTNAME> should have been changed to the name of the FEMIS UNIX
server.

net stop NetWorkTimeProtocol
SWINDIR$\SYSTEM32\PING -w 60000 TEMPLATE HOSTNAME
$SWINDIR%\SYSTEM32\NTPDATE -b TEMPLATE HOSTNAME
net start NetWorkTimeProtocol

The auToExNT . BAT file is invoked at boot up. Its purpose is to synchronize time on the PC while
bypassing the usual NTP time adjustment algorithms. NTPDATE immediately sets the time on the PC
to be the same as on the UNIX server. After boot up, the usual NTP algorithms apply.

4.2.6 Validating the \CONFIGD\NTP.CONF File

During the installation process, the NTP. conF file is copied to the swinNDIrR% directory, usually
C:\WINNT.

The NTP configuration file on the PC should contain at a minimum one drift file and one-or-more

server directives. The format of the drift file directive is driftfile $WINDIR%\NTP.DRIFT, where
$WINDIRS usually is C: \WINNT.
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The format of the server directive is server <hostname>, where hostname is the name of the UNIX
server from which the PC is to acquire time synchronization. Generally, this is the UNIX computer
located on the same Local Area Network (LAN) as the PC. PCs should acquire time synchronization
first from the closest UNIX computer and not from some distant host on the WAN or the Internet.
Distant hosts can be used as a secondary time synchronization source. To designate the primary NTP
host, include the keyword, prefer, in the server directive.

As an example, the following TP . conF file is the preferred format for NTP configuration. It lists the
local UNIX server as the preferred time server and the other (far away) servers as secondary. In this
manner, if the preferred host is inaccessible, one of the secondary servers can provide time
synchronization:

server <IP address of UNIX server> prefer
server <IP addresses of other servers on WAN>
server <IP address of server on the Internet>

driftfile C:\WINNT\NTP.DRIFT

The Network Time Protocol service is very sensitive to the format of this file. Occasionally, in
transferring this file from between UNIX and Windows computers, extra carriage return characters
will be appended to the end of each line in this file. These extra characters are not detectable in a PC
editor, but show up as “*mM” characters at the end of each line in a UNIX editor, such as vi. These
extra characters at the end of a line with a server directive will prevent the Network Time Protocol
service from loading correctly. If the Network Time Protocol service does not appear to be working,
this should be checked.

For more details on NTP set up and configuration methods, see Section 11.0, Server Network Time
Protocol (NTP) Set Up, in the System Administration Guide for FEMIS Version 1.5.

4.2.7 Configuring the \PC\SETUP\FEMIS.DB File

The rEMIs.DB file is used by the FEMIS Network Monitor tool. To configure the servers and routers
to match your network configuration, you will need the server names for all EOCs at the site. If you
have not previously configured a FEmMIs.DB file, it may not exist. Your PC needs to be able to resolve
the host names of all the servers on the network either through a naming service or zosTs file.

Note: Ifthe FEm1s.DB file’s attributes are set to read-only, then ws_waTch. Exe will not be
able to save the new configuration you create, but it will not give any indication of
an error.

1. Execute a telnet session to the FEMIS server by clicking start = Run, and enter telnet
<server>. Logon using the femis account.

2. Change the Permissions on the /home/femis/pc/setup directory and the femis.db file (if it
exists) by entering the following:
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10.

11.

chmod 775 /home/femis/pc/setup
chmod 777 /home/femis/pc/setup/femis.db

Do not close the telnet session window.
Run 1:\pPCc\SETUP\WS_wWATCH.EXE on the PC.

Select File > Load, browse to 1:\PC\SETUP, select FEMIS.DB, and click open. If FEMIS.DB
does not exist, click cancel.

If the FEMIS.DB you opened does not resemble your network architecture, close ws_WATCH. EXE,
delete 1:\PC\SETUP\FEMIS.DB, and restart WS_WATCH.EXE.

Select Edit menu item and modify the grid to match your network. To add a system, select
Add > Host. Anicon will display. Position the icon where you want it.

Click once on the new host, and the host information window displays. Enter the following
information:

Display Name: <server names
Address/Name: <server names
System Type: <server or router>

Type: TCP/IP

Click Accept.

Note: Repeat Steps 2 through 4 for all FEMIS servers, network routers, and other systems
significant to the network at your location. Use the Edit & Add = Line to show

appropriate network connections between items.

Add lines between hosts to resemble network connections by selecting Add - Line and right
click on the beginning and end of the line position.

Delete hosts or lines by selecting Delete = Host/Line. Left click on the host to delete. Right
click on the line to delete.

Select END EDIT, File > save As. Save the file as 1:\pc\sETuP\FEMIS.DB. Ifitis not saved
with this name and location, it will not be installed on the PC during setup.

Exit ws_WATCH.EEXE.



Federal Emergency Management FEMIS Installation Guide
Information Systems (FEMIS) April 26, 2002—Version 1.5

12. Return to the telnet session to the FEMIS server. Change the Permissions on the
/home/femis/pc/setup directory and the FEmMIs.DB file located there by entering the following:

chmod 555 /home/femis/pc/setup
chmod 444 /home/femis/pc/setup/femis.db
exit

13. Close the telnet window.

4.2.8 Updating Files on All PCs Using FUPDATE.BAT

FUPDATE.BAT is a utility that can be used to update any file(s) on all FEMIS PCs such as the HosTs
file or GIS data files. View the 1:\user\fupdate.bat file itself for specific instructions on how to
configure it to update files on all FEMIS PCs.

See Section 15.2, FUPDATE.BAT in the System Administration Guide for FEMIS Version 1.5 for
more details on how to configure FUPDATE . BAT.

4.2.9 Updating the PC HOSTS File

Depending on the DNS and TCP/IP configurations for the local PCs, it may be necessary or desirable
to update the HosTs file on PCs as part of the FEMIS installation. If the PC does not have a zosTs
file and one has been configured on the installation server in the /home/femis/configd directory,
the pc setup program will copy that file to the PC. However, if a HosTs file already exists on the
PC, the pc setup program will not overwrite it.

If it is decided to update the nosTs file on all PCs, the update should be done using the FEMIS
FUPDATE tool. The FUPDATE tool is run as part of the PC Setup program, so updates will be installed
when FEMIS is installed. FUPDATE is also run each time a user logs into a PC, so updates, that are
configured after one or more PCs have been installed, will still be copied to those PCs.

Note: The setup program will not copy the nosTs file to a PC if that PC already has a

HosTs file. See Section 4.2.8, Updating Files on All PCs Using FUPDATE.BAT, if
you need to update the nosTs file on all of the PCs that will be running FEMIS.

4.3 Installing the FEMIS Client Software

This software is for the PC workstations that are connected to the FEMIS data server and contains the
FEMIS client software and a collection of GIS theme files. The installation program for the FEMIS
client software assumes the necessary COTS packages have already been installed.

The FEMIS client software is installed over the network from a UNIX server. The client software
contains over 120 files representing approximately 50 MB of file space.
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The FEMIS executable and other FEMIS support files will be loaded to the following locations:

e current $WINDIRS directory, usually c: \WINNT
e SWINDIRS\SYSTEM32 directory
e C:\FEMIS directory

All files needed by the installation process should have previously been copied from the release tape
or CD to the server. The files specified in Section 4.2, Configuring the FEMIS Setup Program,
should have been configured or validated before the FEMIS client software is installed.

4.3.1 Preparation
To prepare for starting to install FEMIS v1.5, complete the following steps:

1. Login to Windows as administrator or to a Windows account that has Administrator privileges.
Setup will abort if it is run from an account that does not have Administrator privileges.

2. Verify that all COTS needed by FEMIS are installed on the PC. At the minimum, the following
should be installed (the Setup program will also verify that these are installed).

e Microsoft Windows 2000 Service Pace 2 or Windows NT 4.0 Service Pack 6
o Oracle Net8 v8.1.6

e QOracle ODBC Driver v8.1.6.2

e ArcView GIS (ESRI)

Note: FEMIS also requires the PC to map drives to directories on the FEMIS server. If
Samba is being used, no additional software is required on the PC. If an NFS

software package such as Hummingbird Maestro or Sun Solstice NFS Client is being
used, then the client software needs to be installed on the PC.

4.3.2 Running the Setup Program

The FEMIS Oracle database on the UNIX server must be operational before the setup program is run.
1. Close all programs that are running, especially all FEMIS programs, including KeyPrint.

2. Uninstall the previous version of FEMIS using the Add/Remove Programs on the Control Panel.

If you are prompted to remove shared files, select the Yes to all! option.

3. Click ok on the message to restart the PC. If you get a message about creating a shortcut for
fstartup after the PC has restarted, select No or cancel.

Also ignore any messages about a service not being able to start.
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4. Connect your 1:\ drive, and run the 1:\PC\SETUP\SETUP.EXE program, and click Next on the
Welcome window. (See Section 4.2.1, Connecting the Network Install Drive, for instructions on
connecting to the I:\ drive, if you have not already done this.)

Note: The Windows Installer may need to be installed on some Windows NT PCs. If so,
the setup program will install it, and you will need to restart the PC. If the setup
program fails to continue after restarting, remap the 1:\ drive, and rerun SETUP . EXE.

If you are installing on a Windows NT PC, you may get the following error: Internal

Error 2755. 1631, I:\pc\setup\femis.msi. This indicates that a registry key in
HKEY LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Control\Session

Manager\Environment contains a null value. The workaround for this problem is to
remove null environment variables before running the setup program.

5. Click Next on select Site and EoC. This allows you to select the Site and EOC from drop-
down lists. The contents of the lists are controlled by the 1:\coNFIGD\FSETUP. INI file.

6. Click Next on custom Setup. This allows you to select which FEMIS features will be installed.
Verify the FEMIS Location is correct, and click Next. If FEMIS has previously been installed
on the PC, the default is the last place where FEMIS was installed. If this is the first time FEMIS
has been installed on the PC, the default location is c: \FEMIS.

7. Verify the GIS path, and click Next on Select GIS Size and Location. To change the GIS
path, click the change button. To change the GIS size, click on the appropriate size. To ensure
that the necessary GIS files are copied to the PC, do not select the upgrade checkbox when
installing FEMIS v1.5 because the Upgrade option will only regenerate the FEMISGIS.APR file

and skip the copying of GIS data files.

8. Click 1nstall. The program features you selected will be installed. This may take several
minutes.

Note: You may see improved performance from the FEMIS GIS if you choose to install the
GIS on a separate physical disk than the one on which you are installing FEMIS.

Your default database will be set.
As part of this step, the following processes are completed:
e The reEm1s. INT for the PC name, FEMIS and GIS directories, and COTS paths are updated.

e ArcView opens to convert the FEMIscIs. INT file to v1.5 format (if applicable) and to
regenerate the FEMISGIS. APR file.
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e ODBC information for the FEMIS databases is added.

e NTP service to synchronize time on the PC with the server is installed.
e The C:\WINNT\SYSTEM32\AUTOEXNT.BAT file is created.

e Obsolete files from older FEMIS installations are removed.

e FEMIS environment variables, if needed, are added.

Select Yes, I want to restart my computer now. on the Setup Complete window. Click
Finish.

10. Log back in as Administrator after the PC restarts.

4.3.3 Regenerating the FEMIS GIS Dynamic Themes

The FEMIS GIS has both static and dynamic themes. The Setup program installs the files for the
static themes. The files for the dynamic themes are generated by the FEMIS application from data
stored in the FEMIS relational database. These dynamic theme files need to be regenerated after
installing (or reinstalling) FEMIS on a PC.

To regenerate the dynamic GIS themes, complete the following steps:

1.

Start FEMIS and log in.
Select operations mode, and click ox.
Click the map button on the Workbench to start the GIS, and wait for the GIS to load.

Click utility on the menu bar, and select Regenerate Map Layers - Regenerate Point
Map Layers.

Click the utility on the menu bar, and select Regenerate Map Layers > Regenerate
Polygon Map Layers.

Exit FEMIS.

4.4 Configuring the PC

To configure the PC, several configuration and verification processes need to be completed.
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441 Setting Up FEMIS User Accounts on Windows 2000/NT and
UNIX

For Windows 2000/NT to be able to connect to the required FEMIS drives located on the FEMIS
server, a UNIX user account on the FEMIS server must be created for each Windows 2000/NT user
account that will be used to run FEMIS. Each of these UNIX user accounts must have the same
username and password as its corresponding Windows 2000/NT user account. These are separate
from the usernames and passwords that are used to log into the FEMIS application. The usernames
and passwords used to log into the FEMIS application do not need to match the UNIX or Windows
2000/NT usernames and passwords.

Note: Both of the Windows 2000/NT and UNIX user accounts must have the same
username and password so that network drives can connect correctly. Windows

2000/NT and UNIX usernames and passwords are case sensitive. For example:
JSmith and jsmith will not work.

You can set up individual user accounts (such as jsmith) on one or on all of the PCs and the FEMIS
server. Positional accounts (such as sheriff) can be set up on one or all of the PCs and the FEMIS
server. One global (such as femisuser) can be set up on all of the PCs and the FEMIS server, or
some other combination.
Note: Setting up and maintaining individual or positional accounts on all of the PCs and
the FEMIS server can be time consuming, especially if you have many accounts and
many PCs. If the password is changed for an account on one PC, it must be changed
on all the others so they can all still connect to the network drives correctly.

4411 Adding User Accounts to Windows 2000 and NT

To add a user account on a PC, log onto the system with an account with Administrator privileges
and complete the following steps:

For Windows 2000

1. Click start > Settings > Control Panel - Users and Passwords.

2. Select the advanced tab, and click the advanced button under Advanced User Management.
For Windows NT

1. Click start & Program > Administrative Tools > User Manager.

2. Select New User under the User menu item.

3. Right click on the users folder, and select New User.

4-17



Federal Emergency Management FEMIS Installation Guide
Information Systems (FEMIS) April 26, 2002—Version 1.5

Enter values for the following fields:

Username:

Full Name:
Description:
Password:

Confirm Password:

4. Check with your System Administrator to determine which of the following options should be
checked.

User must change password at next logon
User cannot change password

Password never expires

Account disabled

After creating the Windows account, verify the following items.

e The username and password entered are the same as those for this user on the UNIX server
(if not using NT domain authentication via Samba).

e The account is at least in the Users group under the Groups button for Windows NT 4.0 or a
member of the standard User (Power User) Group for Windows 2000.

441.2 Adding User Accounts to UNIX

Refer to Section 2.3.2, Creating Users and Groups, for instructions on adding users to the UNIX
server.

4.4.2 Running the FEMIS Startup Files

FEMIS requires that a network drive be connected in order for items to work correctly. Running the
FSTARTUP . EXE program connects these drives, and this program should be run automatically when a
user logs into Windows. Depending on how your network and PCs are set up, use one of the two
methods listed below for the program to run automatically.

Note: Most sites should use Method 1 and only add the Windows user accounts that will
actually be running FEMIS and have corresponding accounts on the UNIX server.

If both FEMIS and EMIS are being installed on a single Windows account, you will need
to edit the FEMIs. INI file. See Section 4.2.2, Validating [A\CONFIGD\FSETUP.INI File,
for details. This should be done once on the UNIX server before FEMIS is installed on
the PCs.
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Method 1: As a User Login Script

1. Use the User Manager for NT or the Local Users and Groups management console for
Windows 2000 as instructed in Section 4.4.1.1, Adding User Accounts to Windows 2000
and NT.

2. For every user account that will run FEMIS, select the user in the list. Then select the menu item
Properties or Action, and click the Profile button or tab on the form that appears. If you
use a domain to manage user accounts, this should be done on the domain server. Otherwise, this
should be done on each PC that is used for FEMIS.

3. Inthe Logon Script Name field, enter FSTARTUP . EXE.
Method 2: In Startup Folder

1. Using Windows Explorer, open the $A11UsersProfile%\START MENU\PROGRAMS\STARTUP
folder. From the File menu, select New = Shortcut, and a Create Shortcut dialog box displays.
At the Command Line, enter $WINDIRS\SYSTEM32\REPL\IMPORT\SCRIPTS\FSTARTUP . EXE, and
click Next. Enter a name for the shortcut, such as FEMIS Startup Script.

See Section 4.2.2, Validating [\CONFIGD\FSETUP.INI File if you wish to customize the startup.

You can specify additional drives to be mapped by the FEMIS startup script, and specify local startup
scripts to be run after the drives have been mapped.

4.4.3 Verifying the Temporary Directory and Environment
Variables

The GIS and other programs need a directory to store temporary files. Use the following steps to
verify that this process was completed correctly by the Setup program.

1. Select start - Settings > Control Panel - System > Advanced.
(For Window NT, select sStart = Settings = Control Panel > System.)

2. Select Environment Variables.
(For Window NT, select Environment.)

3. Verify there is a User Variable named TemP (usually c:\TEMP). If not, enter TEMP in the
variable field and c:\TEMP in the value field. Click set.
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4. Verify that a FEMISTOPDIR environment variable exists in the System variables box. If not,

select it and change the value in the variable and value text boxes, and click set. The value of

this variable should be set to the directory in which FEMIS was installed.

If you change anything, you must log out of Windows and login again for the changes to take
effect.

5. Click ox to exit the System Properties (Configuration for Windows NT) in the Control Panel.

4.4.4 Verifying the Clock Settings and Time Zone Settings

To set the date format preferences so that FEMIS can process the date correctly, complete the
following steps:

1. Select start - Settings > Control Panel - Regional Options.
(For Window NT, select start = Settings = Control Panel = Regional Settings).

2. Select the Time tab in the Regional Settings window.

3. Verify that you are either using a 24-hour clock (upper case “u” in the Time style field) or a

12-hour clock (lower case “h” in the Time style field) set with the amM and PM symbols are set to

AM and PM (not case sensitive).

4. Verify the time zone is correct in the Control Panel - Date/Time icOn = Time Zone tab.

4.4.5 Verifying the Virtual Memory Setting

For FEMIS to run as efficiently as possible, the computer should be set to have at least 250 MB
(megabytes) of virtual memory. To check the virtual memory setting and increase it, if necessary,
complete the following steps while logged in as Administrator:

1. Click start & Settings > Control Panel - System.

2. For Windows 2000, select the advanced tab, and click the Performance Options button.
For Windows NT, select Performance.

3. Under Virtual Memory click change.

4. Increase the Maximum size to 384 MB for Windows 2000, and if necessary, click set.
For Windows NT, increase the Maximum size to 250 MB, and if necessary, click set.

5. Click ok, click close, and select ves to reboot, if prompted.
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4.4.6 Creating FEMIS Icons

The FEMIS Setup program creates a shortcut on the All Users’ desktop to the FEMIS folder on the
start menu. Ifyou wish to add more shortcuts to the FEMIS folder on the Windows start menu,
you can simply add the shortcuts to the FEMIS folder on the desktop.

If you wish to have any of the FEMIS icons on the desktop, copy the shortcuts from the FEMIS menu
on the desktop to the $A11UssersProfiles\DESKTOP folder.

If you wish to delete any of the shortcuts, right click on the shortcut to be deleted, and select the
Delete option. This will only delete the shortcut, not the program to which it points.

Note: Ifan icon or a shortcut is not created in the A11 Users profile, the FEMIS icon will
only show up for the user under whose profile the shortcut was created.

4.4.7 Final Steps for the FEMIS PC Installation and Configuration

Note: If this is an upgrade installation, you may wish to clean up old icons from the start
> Programs. These may include old icons for the FEMIS program and old icons for
running the startup batch files in the Startup group.

Complete the following steps for the FEMIS installation and configuration:

1. Log out of Windows.

2. Log into Windows as the appropriate user account, and open the FEMIS application.

3. Verify the installation of the first PC thoroughly by following Section 4.6, Validating the FEMIS
PC Installation, before any more PC installations are started. If you must edit any of the

configured files (e.g., ADDODBC.BAT, TNSNAMES.ORA), copy the corrected file back to the server
and install again to be sure that it will work correctly.

4.5 Configuring FEMIS for All PCs at an EOC

The following validation steps need to be performed one time at each EOC. Since these
configuration changes affect values stored in the FEMIS database for the EOC, they will take effect
on all of the PCs using the same database.

4.5.1 Verifying the Zone Name Lookup for EMIS PAR

Note: If both of the following two conditions are true, you must complete this section:
1. You are currently installing FEMIS on an onpost PC.
2. EMIS is used onpost at your site.
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You can skip this section if you are upgrading from an earlier version of FEMIS, and you
performed these steps when that version was installed.

Because EMIS allows users to change zone names at will, there is a possibility that FEMIS and
EMIS zone names will not match exactly. It is important, however, for FEMIS to be able to map its
zone names to the zone names used in EMIS so that Protective Action Recommendations (PARs)
may be shared between the systems. For this reason, a simple utility named rzoNEs . EXE has been
added to the list of system administration software tools available on the PC. This tool allows your
FEMIS System Administrator to set up the EMIS zone name aliases so FEMIS will be able to
correctly map PAR information sent from EMIS. If EMIS is part of the site configuration, then this
utility must be run on the onpost FEMIS at installation and again whenever EMIS changes their zone
names.

4.5.2 Using FZONES.EXE Tool

FZONES . EXE is a system tool that runs on the PC and is located in the directory where FEMIS was
installed (usually c:\rEmMIS). Before you can run this tool, you will need to install at least one PC
with system tools.

This tool displays a two-column spreadsheet of zone information. In the first column, there is a read-
only list of FEMIS zone names. In the second column, there is a writable copy of the EMIS zone
names. When you first start this utility, it will load the values currently in the database for the
FEMIS and EMIS zone names. If at any time during the editing process you wish to reload the
spreadsheet based on the values in the database, click the Reset Spreadsheet button.

To populate the FEMIS/EMIS zone lookup table, you will need to get a list of all the EMIS zone
names for the site. This information may be found on the EMIS server in the following file:
/<disk>/emis3run/emisdyn/data/<site code>/emisgis/giszne.dat. The <disks> and <site
code> will be site specific. Once you have the EMIS list of zones, the simplest way to populate the
lookup table is to run the FzonEgs utility, and then type the EMIS zone names directly in the
spreadsheet next to the corresponding FEMIS zone name. When the spreadsheet is complete, click
the save button.

4.6 Validating the FEMIS PC Installation

This section will assist your System Administrator to validate that the FEMIS system has been
properly installed and is operating correctly.

The FEMIS PC Validation Checklist, provided at the end of this section, includes items that should
be checked to ensure that the FEMIS system is operating properly. The Checklist correlates to the
items listed below. These items are tested from the PC to ensure access and integration into the
FEMIS application.
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If problems are encountered during the validation, refer to FEMIS Troubleshooting guide found
under the Help menu on the FEMIS Workbench for suggestions and guidance.

4.6.1 One Time at EACH EOC
The following validation steps must be performed one time at each EOC.
4.6.1.1 Verify Default D2PC Case Exists

From the FEMIS Workbench or the Navigator, click p2pc. On the D2PC window, select Edit mode,
and select File > Site Defaults - Revert to Site Defaults.

If a message displays stating there is “no current D2PC case selected” Of “no site defaults
yet assigned for this site”, then you will need to create a site default D2PC case.

STOP
If there is not a site default D2PC case, select a case that runs and make it the default case.

Consult with the Hazard Analyst to make sure the new default case is modified to meet the
EOC’s needs and properly saved.

Once the EOC has a default case, repeat this verification section.

4.6.1.2 Verify the Evacuation Command Server

To verify the Evacuation Command server is working properly, you will need to import and run an
Evacuation case. Evacuation cases are located on the 1:\data\evac directory. See the FEMIS Help
for guidance on importing and running a case. Make it your current operational case (on the
Evacuation main window, File - Make Case Current Operat ional).

4.6.1.3 Verify FEMIS/EMIS Data Exchange Interface (DEI)

Note: The definitive description of this interface can be found in Section 7.0, FEMIS Data
Exchange Interface (DEI), in the System Administration Guide for FEMIS
Version 1.5.

To verify that DEI is operating, click the status menu in Operations mode and the select Met

condition. Ifthe current meteorological (Met) data appears in the table, then the DEI is probably
running.
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4.6.1.4 Test the GIS on the Printer

Not all printers display graphics the same. For each printer to which you anticipate printing, use both
KeyPrint and the Print option on ArcView GIS to print a GIS map that contains a D2PC case, Threat
Area, Risk Area and one or more facilities under each. Review the printout to ensure that it prints
graphics in such a way that:

e Risk and No Risk can be differentiated.

e One feature does not totally obscure an underlying feature (e.g., You can still see facilities
located in the Threat Area, and the Threat Area does not wipe out the D2PC isopleths.).

4.6.1.5 Verify User Feedback
Verify the User Feedback option to report software enhancements or problems reports (SEPRs) with

FEMIS can be sent directly to PNNL (ranata.johnsonepnl .gov [Ranata Johnson’s E-mail address]
or blanche.woodepnl .gov [Blanche Wood’s E-mail address]).

4.6.2 Cleanup AFTER Validation

Note: Do not perform the following clean up procedures until completing the
validation steps in Section 4.6.3, Perform on EVERY PC.

After completing the above validations steps, the following cleanup validation steps need to be
performed one time at an EOC, not on every PC.

4.6.2.1 Ensure Exercise #1 Exists

Ensure Exercise #1 or another Exercise is recognized by EMIS has been created. This will allow
EMIS to communicate with FEMIS in Exercise mode.

4.6.2.2 Remove Extraneous FEMIS User Accounts
Remove extraneous FEMIS user accounts that were created during installation and validation. Be

sure to leave the one user account, authorized by your System Administrator that will be used during
the Shakedown Test.

4.6.3 Perform on EVERY PC

The following validation sections should be performed on every PC.

Note: Login to Windows as a user with Administrator privileges.
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4.6.3.1 Ensure FEMIS Login Security

If the PC has a femis account under Windows, make sure that the password is not set to femis.
4.6.3.2 Verify the PC Configuration

Verify each of the following items to make sure the PC’s configuration is correct.

e Icons left from previous installations of FEMIS but are no longer linked to a program should be
removed from the start > Programs - Femis folder.

e KeyPrint is in the startup group for all users.
e Virtual memory maximum size is set to at least 250 MB.

o The FEMIS startup file is called either in each user’s profile or from the 211 User Startup
folder.

e System Environment variable FEMISTOPDIR is defined and set to the directory where FEMIS is
installed.

4.6.3.3 Verify the PC Clock

Verify the PC clock by clicking start = Settings = Control Panel-> Regional Settings. On
the Time tab, make sure you are using either are a 24-hour clock (upper case “u” in the Time Style
field) or a 12-hour clock (lower case “h” in the Time style field) with the am and pM symbol fields
set to AM and PM (not case sensitive).

4.6.3.4 Verify the Network Time Protocol (NTP) Service

To verify the Network Time Protocol (NTP) will synchronize with the server for small variations in
time when the PC is booted up, complete the following steps:

o C(lick start & Programs > Administrative Tools > Event Viewer to the Event View
window. Under the Log menu item, select Application. Check for warning or error messages
(yellow or red icon) with NTP as the source. Troubleshoot as necessary.

e Change the PC clock to a significantly different time (1 hour or more).

e Restart the PC (start - Shut Down > Restart the Computer).

e Login and verify that the PC clock has been reset correctly.
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e From a DOS prompt, enter the command ntptrace. This should return a list of the servers that
are used to synchronize time to the PC. If this does not happen, see Section 4.2.6, Validating the
IA\CONFIGD\NTP.CONF File for more information on this file.

Note: Do not use administrator privileges to perform the rest of the validation steps.
4.6.3.5 Verify Login

For Windows, check to make sure a shortcut to FEMIS exists.

e Validate the ability to access the FEMIS application by double clicking on the FEMIS icon.

e Confirm that the correct default Site/EOC is highlighted.

e Enter a valid usercode and password. The Select Mode window should display.

e If there are Oracle problems with FEMIS from a particular Windows machine, check its path
(Control Panel - System Environmental Variables). Ifthere is an Oracle directory (i.e.,
S:\EMISDYN\ORANT\BIN) referenced that is not pointing to where FEMIS installed Oracle (either
on the c:\ or p:\ drive), then this portion of the path must be removed. Check with the other

software vendors, as appropriate, to be sure this will not cause problems to their software.

e Verify the ability to enter operations mode.

4.6.3.6 Verify Data Manager

Select start = Programs > FEMIS - Data Manager to validate the access to the FEMIS Data
Administration functionality. If the icon is not available, select start - Run and enter or browse to
C:\FEMIS\FDATAMGR.EXE.

4.6.3.7 Verify the System Administration Utility

Select utility > System Utilities > System Admin from the main FEMIS menu bar to
validate the access to the system administration functionality.

4.6.3.8 Verify D2PC
Complete the following steps to verify D2PC.
e C(Click D2PC on the Navigator. Be patient while the initial connection is made to the D2PC

application and the FEMIS database. D2PC should come up with a default case and should be
ready to run. Select Edit mode.
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e Save the D2PC case.

Note: Onpost users may get messages about sending the D2PC case offpost. Click ves,
and close the D2PC window.

4.6.3.9 Verify Notification Service

On the Navigator, you should see a blinking icon (New Data button) that looks like a package. A
magenta bar on the D2PC Function box should also appear. This means that FEMIS data
notifications are being sent and passing messages to your PC. Click the New Data button.

4.6.3.10 Verify GIS

Click the map button from the FEMIS toolbar. The ArcView GIS application should start, and you
should see a base map displayed within an ArcView GIS window.

To check the link between FEMIS and the GIS, select Facilities theme on the left side of the GIS
window. Click the i+ button on the ArcView GIS toolbar; and then click a facility icon on the map.
A view-only facility/resource window should appear.

Do not close the GIS as it will be used in the following steps.

Check the CSEPP Emergency Zones upgrade by creating a Risk Area with all CSEPP zones at risk.
Plot the Risk Area on the GIS. The CSEPP Emergency Zones should turn red.

Check the General Hazard Zones upgrade. Enter a hazard using the general hazard zones as a hazard
layer, and create a Risk Area with all general hazard zones at risk. Plot the Risk Area on the GIS.
The General Hazard Emergency Zones (the county theme) should turn red.

4.6.3.11 Verify Evacuation

If the one-time validation steps have been successfully completed, there should be a current
Evacuation case loaded when the Evacuation window is opened by selecting Function >
Evacuation from the FEMIS Workbench Toolbar. If the network was previously created on this PC,
you can observe the network displayed on the GIS. If Evacuation has not been previously executed
on this PC, you will get a message telling you to create a network. On the Evacuation window, select
File - Create Network, and the network is created and displayed on the GIS.

4.6.3.12 Verify Electronic Planning
To verify that FEMIS Electronic Planning is working, click on utility - Planning
Development, and selecta plan. Examine the Navigator window to be sure the validation plan has

been selected. If you can do this without any error messages and tasks appear in the spreadsheet;
then the Electronic Planning should work properly.
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4.6.3.13 Verify Help

Click the #elp button to activate the online Help to verify the Help subsystem is working properly.
All help files should be checked. This includes the on-line Troubleshooting Guide.

4.6.3.14 Verify Printer

Verify KeyPrint was enabled at log in. Use KeyPrint or the print Screen button on any FEMIS
window to ensure the PC is properly connected to a printer.

4.6.3.15 Verify FEMIS Tools

Verify on a FEMIS PC with System Tools installed. Click on each of the FEMIS Tools (FEMIS
Monitor PC, FEMISMon Watcher, and Network Monitor) to ensure they are operational.
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Machine Name:

Admin Password:

Task

Notes

Initials

4.1.1 — Installing Windows 2000 Service Pack 2 or
Windows NT 4.0 Service Pack 6

4.1.3 — Installing Oracle Net8 Client v8.1.6 and
ODBC v8.1.6.2 (patches)

4.1.5.1 — Installing ArcView GIS v3.1.1
4.1.5.2 — Installing ArcView GIS v3.1.1 Patch

4.1.6 — Installing Other COTS; Site Specific

4.2 — Configuring the FEMIS Setup Program
(Once at Each EOC)

4.2.9 — Updating the PC HOSTS File

4.3 — Installing the FEMIS Client Software

4.4.2 — Running the FEMIS Startup Files

<l Bo BN BENEN Be)

4.4.3 — Veritying Temporary Directory and
Environment Variables

4.4.4 — Verifying Clock Settings and Time Zone
Settings

11

4.4.5 — Verifying Virtual Memory Setting
(Maximum to at least 384 for Windows 2000 and
250 for Window NT)
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PC

Name:

Validated using Window 2000 or Windows NT 4.0 Login:

One Time at Each EOC:

Notes

Initials

1

Verify Default D2PC Case exists

2 | Verify the Evacuation Command Server
Only on the server with the depot database, verify FEMIS/EMIS
Data Exchange Interface (DEI)

4 | Test the GIS on the printer

Verify User Feedback option

Clean Up AFTER Validation:

1 | Ensure Exercise #1 exists or whatever exercise is recognized by
EMIS

2 | Remove extraneous User Accounts s created during validation

Perform on Every PC:

1 | Ensure Windows login FEMIS/FEMIS does not exist

2 | Verify the PC configuration

3 | Verify the PC clock

4 | Verify Network Time Protocol (NTP) service

5 | Verify link to M:\ drive (for Evacuation)

6 | Verity login

7 | Verify Data Manager

8 | Verify system administration

9 | Verity D2PC

10 | Verify notification service

11| Verify GIS

12| Verity ViewMarks

13 | Verify Evacuation

14 | Verify Help

15| Verify printer

16 | Verify FEMIS Tools on appropriate PC(s)
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